Drawing Register – User Guide
Thank you for downloading Drawing Register for Microsoft Excel 2002 & onwards ( http://www.alanwelsman.co.uk/drawingregister.html )
I hope it helps you as much as it has helped me over the past few years, although much effort has already gone into the creation and continual
development of Drawing Register, I am still happy to receive any comments or concerns you may have purely in relation to Drawing Register
and it's functionality to alanwelsman@alanwelsman.co.uk.
There are no restrictions set to how you wish to use Drawing Register, my only comment would be not sell this freely available program as it
remains the property of Alan Welsman at all times, Drawing Register has been registered for protection with the UK Copyright Service.
Donations: Drawing Register is 100% free, being free comes with an inbuilt counter, every 50 times used you will see a message as follows:
"If you feel as though my efforts of writing Drawing Register has achieved it's goal of helping you within your scope of works and at your
discretion would like to contribute something as a token gesture towards keeping future versions of Drawing Register and it's hosting website
alive, you can do so via a Paypal Donation, any contribution will be gratefully appreciated, you will be directed to my web site once this
message box has disappeared, again thank you for using Drawing Register"
To escape the donation message, simply press the [ Escape ] button on your keyboard.
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Note 1: Where written DR in this document simply means Drawing Register.
Note 2: When you open DR, you will be asked to enable/disable macro's, please enable them.
Note 3: When you close DR, you will not be asked to save, DR automatically performs this task upon exiting to ensure all data is saved.
Note 4: When you select "Save As" DR will create a backup of itself called "Drawing Register - Backup.xls".

What is Drawing Register and what is it's purpose?
Drawing Register is a tool to help provide very fast access to a specific range of documents stored on your own PC or on your remote server.
Drawing Register is a Microsoft Excel file, created using Microsoft Excel 2002 and Visual Basic ensuring it's compatibility with future revisions.
Being a stand alone Excel file eliminates the need for it to be installed into your operating system like traditional software is.
It's purpose is to help you distribute your documents efficiently and to help your colleagues locate and share those documents faster with
much less effort saving you and your business money by cutting time wasted trying to locate specific documents.
Based around electronic file tagging, DR allows you and your colleagues to search to clone, compare, delete, open, view, print and speedmail
your superseded or latest working documents from your desktop directly to your audience even if your PC is connected remotely.
For personal use simply update the local file database of files sitting on your own PC, for network use, Drawing Register requires one person to
take control of updating the network file database so it can be automatically downloaded by all other Drawing Register network users.
There is no need to purchase additional software as DR is already compatible with Microsoft Office and it's Excel package.
2 versions of Drawing Register now exists, the original xls which is compatible with Excel version 2002 and onwards and the newer version xlsb
which is compatible with Excel 2007 and onwards, the xlsb version works exactly the same as the previous xls version.
The xlsb ( Excel Binary ) improves its overal performance, quicker at opening, saving and closing, uses less disk space and calculates quicker.
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How to Upgrade
From time to time "Drawing Register.xls" will be revised to include new features or to correct minor bugs if found.
As soon as the improvements are made, the uploading of DR is instantaneous.
If you open DR and are alerted to an upgrade message like the one detailed below, please proceed to download the newer version.
< When you see a message similar to this one,
your Pref's and Local data is automatically backed up.
Your data is stored into the backup file FileList.xls which sits
locally on your PC or the file FileList.xls which sits on your server
if you are setup as an administrator.
The backup file FileList.xls will be cloned and will be renamed
to include both date & time similar to the following example:
FileList - Copy 2016-06-13 13-06-00.
At present, the upgrade can only be carried out manually.
THERE ARE NOW 2 VERSIONS TO CHOOSE FROM
Using Excel 2002/2003, use Drawing Register.xls
Using Excel 2007 onwards, use Drawing Register.xlsb

Above is a screenshot from Drawing Register version 1.21 where it has checked online and has found a newer DR version being 1.22.
On finding the newer version, it has automatically backed up your records, just follow the sequence below to complete the upgrade process.
Note: Because you can not overwrite an open file, you will need to close down your current version of Drawing Register.
1. After you press [ OK ], your web browser will open, you will be directed to the new update.
Your web browser will open and you will be directed to the website "http://www.alanwelsman.co.uk/drawingregister.html".
This is where you can download the new version of Drawing Register, make sure you select the correct Excel version.
2. Close down this version of Drawing Register.
3. Press the [ Download ] then [ Save As ] buttons.
On the website "http://www.alanwelsman.co.uk/drawingregister.html" are 2 buttons labelled [ Download ].
Press the left button to download in xls format or press the right button to download in xlsb format.
You will be asked what you would like to do with the download, the choices are Open / Save / Save As, select [ Save As ].
4. File Explorer will open on your PC, you will need to navigate to the folder containing the old version of Drawing Register.
5. Press the [ Save ] button, a Confirm Save As warning message will appear:

Select [ Yes ] to allow the overwriting of the old file.

6. After download, right click new Drawing Register.xls or xlsb file.
Before you open your new version of Drawing Register.xls or xlsb, right mouse click the file.
7. Select Properties then press the Unblock button and then the Apply button and then the OK button.
8. Open Drawing Register, enable macro's ( if asked to enable them ) then select the worksheet tab Local.
Your existing records will be imported from the file FileList.xls automatically.
You have now updated to the latest version of Drawing Register.
You will be asked 3 times to create new passwords when closing.
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Notes
Each time you download "Drawing Register", right mouse click the file then select "Properties" from the list of options.

.
< Press "Unblock", Apply then OK button's to make "Drawing Register" a trusted file.
This will allow the hyperlink function "File Open" to work without the repeated
security warning pop-up message advising you that you are about to open a file.
Note: Excel 2013 does not yet have a solution to stop virus pop-up messages.

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Please ensure you have installed the component Visual Basic prior to running DR, DR will not function correctly without it.
When you open DR, you will be asked to enable/disable macro’s, please enable them.
Macro’s within DR are safe, they are small automated programs which run in the background of DR when called upon.
If DR discovers the remote file "FileList.xls" is missing, DR will attempt to create one, if this happens, select "Yes".
When you close DR for the first 3 times, you will be asked on each occasion to create a "Password" of your choice.
On the "1st" attempt, create a password and write into both boxes - Note: You can see the password!
On the "2nd" attempt, if you wish to change the passwords, enter your new passwords, otherwise press "Cancel"
On the "3rd" attempt, if you wish to change the passwords, enter your new passwords, otherwise press "Cancel"
If the "2nd" and "3rd" attempt were left blank, the password will stay as the password entered on the "1st" attempt.
Each time DR opens, "Quick Search" will be the first screen you will see ready for searching your files.

< When you close DR for the first 3 times, you will be presented with this form.
Create new passwords to protect data within DR.
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Changelog
V1.25: 02-05-2017

Have had to alter the VBA script containing the word "shell32.dll" as email and Web browsers were reporting a false positive.
Please be assured Drawing Register is not in any way shape or form programmed to act as a Trojan software tool.
Have re-arranged and have added a new Quick Search tool box to allow more tools to be added at future dates.
Have added a new calculator to calculate the neutral current on 3 phase imbalanced distribution systems.
Have added a link to show what the different parts of the Quick Search screen does.

V1.24: 21-03-2017

Have made minor changes to read the backup file "FileList" and import it's details faster.
Have amended VBA so if you are an administrator you will work with a backup file "FileLis1" instead of "FileList".
Have amended VBA for Quick Search to correctly show conditional formatting if your Excel version is 2007 or 2010.
Have rectified the Speedmail formula as selecting some recipients would add other recipients in error.

V1.23: 28-02-2017

Have re-arranged the two Quick Search options boxes to make them easier to understand and use functions.
Have included two new calculators for electrical engineers to help calculate 1Ph & 3Ph units to other units.
Have modified the updating system as Excel would hang if you selected to close Excel down automatically.
Have modified "Prefs Setup Assistant" to 10 presets, preset 9 now includes the management of requisitions.

V1.22: 28-01-2017

Add function: Have included the ability to search within specific dates by pressing the info bar within Quick Search.
The custom dates dialogue has 8 pre-set dates also providing the option to add your own custom dates.
Have modified the info bar to show more specific information and display custom dates if they are in use.
Have amended the Quick Search code due to results displaying files as "not available" when they were available.

V1.21: 23-12-2016

Speedmail: Have amended the vba code to include your own email signature if one exists.
Have modified the vba code to allow the transferring of superseded files whilst in the Quick Search - shortcut is CTRL+m
Have modified "Prefs Setup Assistant" option 8 - to setup and include the record keeping of personal wage-slips.

V1.20: 15-11-2016

Speedmail: Have included a 180 person emailing list making it easier to transmit your documents via speedmail.
Have corrected a minor bug when entering xlsb as the FileList extension, it will now write and read correctly.
Have corrected a minor bug within Quick Search to correctly list the list from number if using multiple fields.
Have corrected a minor error within the Quick Search, Print File VBA code to work with Office 64 Bit.
Have corrected a minor bug where non-administrators could accidentally update the FileList upon file exit.

V1.19: 06-10-2016

When opting to change passwords, the xlsb vba code would write as xls instead of xlsb - now corrected.
This only affected Drawing Register.xlsb file version.
Have corrected a minor bug in relation to importing and exporting data to and from the FileList backup.

V1.18: 24-09-2016

Have created an alternate version of DR for use with Excel 2007 and above - it's format is xlsb ( Excel Binary ).
The xlsb file format reduces the original xls file from 2.8Mb to 612Kb and vastly improves performance.
Have removed the option to delete *.tmp files on file exit and have replaced it with the FileList extension type.
If you currently use DR your existing FileList extension will be xls, leave blank to continue with xls formats.
If you opt to use Drawing Register.xlsb file version, you can still continue to read the FileList.xls backup file.

V1.17: 22-09-2016
V1.17: 21-09-2016
V1.17: 15-09-2016

Have included the ability to reprogram Hyperlinks to open files by row or column selection.
Have corrected a minor bug to allow Drawing Register to function correctly using Excel 64Bit.
Have altered the DR.Chat coding to stop Drawing Register opening by itself.

V1.16: 15-08-2016

Have added the ability to print your company logo on all sheets by adding a logo.png into the ChatPath folder.
Have updated the Export coding to enable it to work more efficiently and close FileList.exe if it is locally open.
Have updated the Prefs Storage Assistant to include the column width settings of Current / Superseded sheets.
Minor bug fixed: C/Files & S/Files coding now correctly places the details of new files within the Local database.
Have updated the DR.Chat system to stack up to 9 messages on the server if the recipient is currently away.

V1.15: 15-07-2016

Add function: Any Path file with it's extension in capitals is automatically changed to lower case.
This feature is only available when you are setup as an administrator so the files can be managed correctly.

V1.14: 14-06-2016

Have updated the DR.Chat system to display the correct windows login user's name.

V1.13: 15-05-2016

Have updated the Prefs Storage Assistant to show all of the 20 file reference names simultaneously.

V1.12: 15-03-2016

New users can choose between 8 setup examples during 1st time use, databases are setup automatically.
Have added encryption into all DR.Chat messages, recipient's details and the message body text is encrypted.
Have included the settings for Display Properties and Quick Search/Row heights into the FileList backup file.

V1.11: 15-11-2015

Add function: On file open, auto-hide the ribbon to allow more results to be displayed.
Resolved issue when selecting audio files they are played in turn and as per their correct duration.
MP3 file details, Genre / Author / Duration / Track Name and Year are database auto populated.
Have increased both path folder databases to hold 5000 file records instead of 2000 records.
Have amended both path folder code to auto enter the details of new files into the local database.
Have added the feature Pref's / WebPath to allow your search results to be viewed within a web browser.
Have added the ability to chat to other DR users if on the same LAN and sharing the same server folder.

V1.10: 15-08-2015

Add QS function: Under group search, entering ?? will list the different group types.

V1.09: 17-05-2015

Add QS function: Choose specific records from a search report by selecting it's row number.
Add function: On file open, auto-check for a Drawing Register update and show the new version available.
If a new version is available, auto-backup all current settings & databases to the backup file FileList.
Clone FileList renaming it to include both date & time as example: FileList - Copy 2016-06-13 13-06-00.

V1.08: 15-02-2015

Add QS function: Add the option to Speedmail, attach and add their filenames into an email body.
Add Speedmail function: Auto import a speedmail.xls database into the DR/Local database if found.

V1.07: 15-11-2014

Code upgrade: Enable faster file searching across networked folders when connected via VPN.

V1.06: 15-08-2014

Add QS function: Add the Quick Search Options dialogue box to provide a better user interface.

V1.05: 15-05-2014

Code upgrade: Perform faster sorting of databases without having to unprotect worksheets.
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Changelog continued
V1.04: 15-02-2014

Pref's: Increase the number of search engines to 5 and add the ability to configure those search engines.

V1.03: 15-11-2013

Add function: List files within both path folders to produce live database reports of folder contents.
Add function: Right mouse click a path folder filename to move that particular file between folders.

V1.02: 15-08-2013

Add function: If the backup file FileList does not exist, create it and auto-backup DR/Pref's & Local.

V1.01: 15-07-2013

Add function: When opening DR, apply worksheet protection and user environments.
Add function: When closing DR for first 3 times, add the option to add or change your user passwords.

V1.00: 13-06-2013

Initial build in 2013 for personal use.
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Problem Solving
If you try to use DR and find things are not working as they should do, try the following.
1. Close DR then Re-Open, when asked to enable/disable macro’s, please enable them.
2. Change between any worksheet tabs, this will kick-start and reset automatic functions.
3. Screen size does not automatically change: Ensure when you open DR, you enable macro's.
4. Excel does not appear to be calculating or changing values: Ensure Excel Tools / Options / Calculations is set to "Automatic"
Hyperlink issues arose after uninstalling Google Chrome on a Windows based PC, many DR hyperlinks ceased to function, there is an issue
where the registry file is not completely reset during the uninstallation process of Google Chrome, this can be fixed but recommend should be
done by users experienced in the Microsoft Windows system registry file, the fix is to search for all values labelled as “ChromeHTML” or
“FireFoxHTML” and rename them as “htmlfile”.
If one on your columns refers to drawing scales, instead of writing 1:100 write 1 to 100 - Don't use the colon.
If some of your filenames consist of numbers only, try not to use filenames greater than 15 numbers in length, add text within their filename.
If at any time all automatic functions appear to stop working, carry out any of the 4 options above, if those options still fail to resolve the
issue, close DR then re-open making sure to enable macro's.
When requesting to delete files, you can only delete files on your own PC unless you are setup as an administrator.
In either case, you will be asked 3 times to confirm the delete process, deleted files do NOT go to the recycle bin and deleted files can NOT be
restored.
On Microsoft Windows based PC's running Office 2013 and later, you may experience repeated security warning messages each time you try
to open hyperlinked files, this is an automated security response setup within the programming of Microsoft Office, earlier versions of Office
do not show the messages, if you want to stop the messages, refer to the section Notes on Page 3 above and the unblocking of DR.

Cut, Copy & Paste
When you open "Drawing Register", the following function's will be temporarily disabled then restored when closed.
1. Allow cell drag & drop ( Disabled ).
2. Formula Bar ( Hidden to maximise screen space ).
3. Ribbon toolbar in Excel 2007 & above ( Hidden to maximise screen space ).
4. Insert / Delete / Rename / Move or Copy Worksheet ( Disabled ).
If you need to copy the contents of the worksheet Local to another workbook's worksheet, you will need to type the letter "X" into the
worksheet Prefs under the section Page Zoon Auto or % / Local this will pause the function as item 3 above.

System Requirements
DR has been written within the parameters of Microsoft Excel version 2002 (v10.0), 32 bit running on a Microsoft Windows based PC.
The current version of DR has been tested using Excel 2002 (v11.0), 2007 (v12.0), 2010 (v14.0) without any issues.
DR has been tested on Excel 2013 (v15.0) but are not yet able to stop the pop-up virus warning from showing when hyperlinking.
Minimum requirement is to have a Windows based computer system running Excel 2002.
The Drawing Register.xls file is approx 3.0Mb ( Mega bytes ) in size.

Feedback
If you use DR and believe you have an idea which could be integrated into DR and it's future revisions, please feel free to email me your
comments.
If you disagree with a comment or function I have written into DR, again feel free to comment: alanwelsman@alanwelsman.co.uk

Company Logo's
If you wish to include your company logo into the header of each printed document, simply add your logo into the ChatPath folder.
The logo must be saved as file format png i.e.: logo.png and must be approx 130 pixels high x 400 pixels wide.
If a logo is not within the ChatPath folder, a message on the top left of each sheet will describe what name, format and size one can be.
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1st Time Use
The very first time DR is opened, you will be presented with the 30 second message as displayed below, it is displayed twice only.
You can clear the message by pressing the keyboard [ esc ] key or wait the 30 seconds.

New Users
Select the worksheet Pref's where you will be presented with
the Prefs Setup Assistant as shown below.

Existing Users
Select the worksheet "Local" where your existing records will be
imported for you.

After you have selected the "Prefs" worksheet, you will see the Prefs Setup Assistant offering 8 database examples to choose from.
Currently, there are 7 database example's to choose from with the additional 1 to follow.
Note: These are examples and are pre-programmed, you can still create database's of your own and record them.

1. Drawings:
2. Receipts:
3. MP3 / MP4 Audio/Video:
4. Assets:
5. Inductions:
6. Plant:
7. Productivity / Delays:
8. Wage Slips:
9. Requisitions:
10. TBC:

Use for site drawings in their pdf format.
Use for personal receipts in their pdf format.
Use for personal media content in either mp3 or mp4 format.
Use for insurance purposes to record your assets in picture jpg format.
Use for site inductions in their pdf format ( can also be jpg format ).
Use for site plant, manage the audit trail for plant and who is using it in their pdf format.
Use for site operatives, record their productivity and builders delays.
Use for personal use of tracking your wage slips.
Use for tracking site orders and deliveries of goods.
Future use.
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Setup for local or network use ( Local )
Local / Personal Use ( You do not need to be an administrator to carry out this process )

General
User
Info

C-Path >
S-Path >
ChatPath >
WebPath >

1
2a-2f
3a-3b
4a-4b
5a-5b
6a-6b
7

Please enter your site location name and email subject title your documents relate to >
Please enter 4 C/S-Path folder header codes & 2 Local new file found header codes >
Please enter the text to be displayed for New ¦ Open files within C/S-Path folders >
Automatically update the contents of C-Path ¦ S-Path folders during file open? >
File extension of document's e.g.: "pdf" ¦ File extension of FileList e.g.: "xls" >
Automatically update the Local database on file open ¦ Local or Network >
Enter code to enable export to remote "FileList" & delete physical files >

A

> Your Site & Contract No Here <
D
E
G
K
New >
Open >
Yes
Yes
pdf
xls
No
Local

H

C:\Users\Alan Welsman\Desktop\
C:\Users\Alan Welsman\Desktop\Superseded\
C:\Users\Alan Welsman\Desktop\
http://www.ebay.co.uk/sch/

1. Onto your PC, create a folder called Drawings and inside that folder, create another folder called Superseded.
2. Into the folder called Drawings, download the file Drawing Register.xls - link: www.alanwelsman.co.uk/Drawing Register.xls
3. Right click the downloaded file Drawing Register.xls, select Properties, then press Unblock, then Apply then OK.
4. Create a shortcut to the file Drawing Register.xls and if required place it onto your desktop.
5. Into the folder called Drawings, put all your active/current drawings or documents ( ensure all are 1 type of file i.e pdf ).
6. Into the folder called Superseded, put all your outdated/superseded drawings or documents ( again 1 type of file i.e pdf ).
7. Go to your desktop and click the shortcut for the file Drawing Register, ensure you enable macro's or content when asked.
8. When you open DR, it will create a backup file called FileList.xls, please allow it to do so.
9. Select the worksheet Pref's, right mouse click the red No.1 to auto-setup defaults for Q1 to Q6b.
10. Select the empty cell for C-Path > and right mouse click it, the default path will be entered for you.
11. Select the empty cell for S-Path > and right mouse click it, the default path will be entered for you.
12. Select the empty cell for ChatPath > and right mouse click it, the default path will be entered for you.
13. Select the empty cell for WebPath > and enter an alternative website search engine to view your quick search results.
14. Select the worksheet Current and press the Update button, press until the words New > or Open > appears, arrow left then up.
15. Select the worksheet Superseded and carry out the same as written in line 12.
16. Select the worksheet Local and proceed to enter details against any new files found in the available empty spaces.
17. Select the worksheet Quick Search and enter a search string to display any matching records, select files to open them.
18. Select the worksheet Pref's, press the HELP button then press the button Export to FileList > to backup DR/Local database.
%20
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Setup for local or network use ( Network ) ( Network Server - Administrators to setup and manage this file )

General
User
Info

1
2a-2f
3a-3b
4a-4b
5a-5b
6a-6b
7

C-Path >
S-Path >
ChatPath >
WebPath >

Please enter your site location name and email subject title your documents relate to >
Please enter 4 C/S-Path folder header codes & 2 Local new file found header codes >
Please enter the text to be displayed for New ¦ Open files within C/S-Path folders >
Automatically update the contents of C-Path ¦ S-Path folders during file open? >
File extension of document's e.g.: "pdf" ¦ File extension of FileList e.g.: "xls" >
Automatically update the Local database on file open ¦ Local or Network >
Enter code to enable export to remote "FileList" & delete physical files >

A

> Your Site & Contract No Here <
D
E
G
K
New >
Open >
Yes
Yes
pdf
xls
No
Network
123456 654321

H

C:\Users\Alan Welsman\Desktop\
C:\Users\Alan Welsman\Desktop\Superseded\
C:\Users\Alan Welsman\Desktop\
http://www.ebay.co.uk/sch/

1. Onto your server, create a folder called Drawings and inside that folder, create another folder called Superseded.
2. Into the folder called Drawings, download the file Drawing Register.xls - link: www.alanwelsman.co.uk/Drawing Register.xls
3. Right click the downloaded file Drawing Register.xls, select Properties, then press Unblock, then Apply then OK.
4. Create a shortcut to the file Drawing Register.xls and place it onto your desktop.
5. Into the folder called Drawings, put all your active/current drawings or documents ( ensure all are 1 type of file i.e pdf ).
6. Into the folder called Superseded, put all your outdated/superseded drawings or documents ( again 1 type of file i.e pdf ).
7. Go to your desktop and click the shortcut for the file Drawing Register, ensure you enable macro's or content when asked.
8. When you open DR, it will create a backup file called FileList.xls, please allow it to do so.
9. Select the worksheet Pref's, right mouse click the red No.1 to auto-setup defaults for Q1 to Q6b.
10. Select box 7 and enter the word admin then right mouse click the word FileList in the question to have a code appear.
11. Select the empty cell for C-Path > and right mouse click it, the default path will be entered for you.
12. Select the empty cell for S-Path > and right mouse click it, the default path will be entered for you.
13. Select the empty cell for ChatPath > and right mouse click it, the default path will be entered for you.
14. Select the empty cell for WebPath > and enter an alternative website search engine to view your quick search results.
15. Select the worksheet Current and press the Update button, press until the words New > or Open > appears, arrow left then up.
16. Select the worksheet Superseded and carry out the same as written in line 13.
17. Select the worksheet Local and proceed to enter details against any new files found in the available empty spaces.
18. Select the worksheet Quick Search and enter a search string to display any matching records, select files to open them.
19. Select the worksheet Pref's, press the HELP button then press the button Export to FileList > to backup DR/Local database.
20. Close DR and make sure you add a password to open and modify so only you can update and manage the FileList database.
%20

Administrator - If you want to administer remotely, still carry out the process 1 to 20 above, then move the file Drawing Register.xls to your
personal desktop and follow the additional steps 21 to 25.
21. Open the moved file DR using your passwords and allow a new backup file FileList.xls to be created.
22. Select the worksheet Pref's then select cell 6b and enter the text Net or Network.
23. Press the word C-Path > and navigate to the drawings folder setup on the server, press OK when done.
24. Press the word S-Path > and navigate to the superseded folder setup on the server, press OK when done.
25. Select the worksheet Pref's, press the HELP button then press the button Export to FileList > to backup DR/Server database.

Network ( Client work- stations - You do not need to be an administrator to carry out this process )

General
User
Info

C-Path >
S-Path >
ChatPath >
WebPath >

1
2a-2f
3a-3b
4a-4b
5a-5b
6a-6b
7

Please enter your site location name and email subject title your documents relate to >
Please enter 4 C/S-Path folder header codes & 2 Local new file found header codes >
Please enter the text to be displayed for New ¦ Open files within C/S-Path folders >
Automatically update the contents of C-Path ¦ S-Path folders during file open? >
File extension of document's e.g.: "pdf" ¦ File extension of FileList e.g.: "xls" >
Automatically update the Local database on file open ¦ Local or Network >
Enter code to enable export to remote "FileList" & delete physical files >

A

> Your Site & Contract No Here <
D
E
G
K
New >
Open >
Yes
Yes
pdf
xls
Yes
Network

H

C:\Users\Alan Welsman\Desktop\
C:\Users\Alan Welsman\Desktop\Superseded\
C:\Users\Alan Welsman\Desktop\
http://www.ebay.co.uk/sch/

1. Onto your PC, create a folder called Drawings.
2. Into the folder called Drawings, download the file Drawing Register.xls - link: www.alanwelsman.co.uk/Drawing Register.xls
3. Right click the downloaded file Drawing Register.xls, select Properties, then press Unblock, then Apply then OK.
4. Create a shortcut to the file Drawing Register.xls and if required place it onto your desktop.
5. Go to your desktop and click the shortcut for the file Drawing Register, ensure you enable macro's or content when asked.
6. When you open DR, it will create a backup file called FileList.xls, please allow it to do so.
7. Select the worksheet Pref's, right mouse click the red No.1 to auto-setup defaults for Q1 to Q6b.
8. Re-select cell 6a and type Yes to enable the auto-importing of server database details.
9. Re-select cell 6b and type Net or Network to tell DR it's database details is being imported from a networked source.
10. Press the word C-Path > and navigate to the drawings folder setup on the server by the administrator, press OK when done.
11. Select the empty cell for S-Path > and right mouse click it, the default path will be entered for you.
12. Select the worksheet Quick Search and enter a search string to display any matching records, select files to open them.
Please peruse the remainder of this document to see how to use specific worksheets.
%20
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Setup for using mp3 files
Drawing Register has been adapted to automatically create a database of your audio files, this is to eliminate the tedious task of entering the
extended file attributes into DR's local database yourself.
Below is the Pref's setup used, C-Path & S-Path will be your own path's

General
User
Info

Please enter your site location name and email subject title your documents relate to >
Please enter 4 C/S-Path folder header codes & 2 Local new file found header codes >
Please enter the text to be displayed for New ¦ Open files within C/S-Path folders >
Automatically update the contents of C-Path ¦ S-Path folders during file open? >
File extension of document's e.g.: "pdf" ¦ File extension of FileList e.g.: "xls" >
Automatically update the Local database on file open ¦ Local or Network >
Enter code to enable export to remote "FileList" & delete physical files >

1
2a-2f
3a-3b
4a-4b
5a-5b
6a-6b
7

C-Path >
S-Path >
ChatPath >
WebPath >

T

C:\Users\Alan Welsman\Desktop\
C:\Users\Alan Welsman\Desktop\Superseded\
C:\Users\Alan Welsman\Desktop\
https://www.youtube.com/results?search_query=

Header
Codes

A1
Genre
K1
N/a

Col Width's
134.58
134.58
134.58
134.58
134.58

Engine
A
B
C
D
E

B1
Author
L1
N/a
A+

Format Codes

> Your Compilation Title Here <
D
B
C
E
New >
Play >
Yes
Yes
mp3
xls
No
Local

A

C5
Mins
M1
N/a
18

Search1
A+ 18
A+ 18
A+ 18
A+ 18
A+ 18
( 1 ) Text
#

B+

D1
Track
N1
N/a
34

Search2
B+ 34
B+ 34
B+ 34
B+ 34
B+ 34

C

E1
Year
O1
N/a
7.29

Search3
C 7.29
C 7.29
C 7.29
C 7.29
C 7.29

( 2 ) Numbers
#,##0.00_ ;[Red]-#,##0.00

D+

F1
N/a
P1
N/a
34

Search4
D+ 34
D+ 34
D+ 34
D+ 34
D+ 34

E

G1
N/a
Q1
N/a
7.29

Search5
E 7.29
E 7.29
E 7.29
E 7.29
E 7.29

( 3 ) Dates
dd-mmm-yy

F

H1
N/a
R1
N/a
0

Search6
F0
F0
F0
F0
F0

G

I1
N/a
S1
N/a
0

Search7
G0
G0
G0
G0
G0

( 4 ) Money
£#,##0.00;[Red]-£#,##0.00

H

J1
N/a
T1
Comments
0

Search8
H0
H0
H0
H0
H0

T+

34

Search9
T+ 34
T+ 34
T+ 34
T+ 34
T+ 34

( 5 ) Other
hh:mm:ss

1. Enter the details as detailed above from this page into the "Pref's" section of Drawing Register.
2. Select the worksheet "Current"
3. Press the "< Update" button until the database list shows the words "New >" or "Open >"
4. Any new audio files found within the "C-Path" folder will be automatically entered into the "Local" database.
5. Select "Quick Search" and under the title "Track" enter a "?" to list all available tracks.
6. Select any track to hear only that song or right click in any empty space to view more options and press play files.
7. Select multiple tracks from the list by selecting its row number in red, it will highlight yellow, repeat for other tracks then right click an
empty space to view more options then press play files.
8. Double click the red number "1" so all the row numbers highlight orange, each file selected will be opened on the web.
To save the settings of the "Pref's", select the "Pref's" worksheet then press the "HELP" button.
Press the button "Export to FileList >", this will backup your "Pref's" settings as well as your "Local" database.
If you then want to load another "C-Path"'s database, delete the word listed in item "1" ( example above is Audio Files ) then press the path
"C-Path" to bring up the folder dialog box, choose the folder containing another "FileList" database then press the enter button.
On the "Pref's" page, press the "HELP" button then press the button "< Import from FileList", this will load its database and "Pref's" settings.
Note
Whilst within the "Current" worksheet and pressing "< Update" shows your audio tracks with two sets of file extension i.e ".mp3.mp3", you
will need to switch off "show or hide file extensions" types within the folders setup.
DR is looking for "mp3" files and is adding the extension "mp3" to all audio tracks it can find, if you already show the file extension, DR is
adding it again.
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HELP

Located on the worksheet "Pref's" is a button labelled "HELP", if pressed will display the dialogue box displayed above.
As well as displaying a guide on how to setup Drawing Register, the dialogue box has 6 other functions and are as follows:
1. http://www.alanwelsman.co.uk/software.html is the hyperlink address where you can download "Drawing Register.xls" from.
2. < Import from FileList is the button to press to import records from the file "FileList" to "Drawing Register.xls".
3. Export to FileList > is the button to press to export records from the file "Drawing Register.xls" to "FileList".
Note: Only administrators can export data to the FileList if the file FileList is located on a networked server.
Note: Every time you press export, your "Pref's" settings will also be exported to the "FileList" for safe backup.
4. Copyright Law UK - Explained is the hyperlink to press to view the UK law on copyright material, "Drawing Register.xls" included.
5. Download User Guide is the button to press to download the user guide you are currently reading.
6. Donate is the button to press to make a token gesture donation via PayPal to the creator of "Drawing Register.xls".
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Pref's
HELP: Press this button to view a quick setup and user guide and to compare database records between DR and FileList, administrators can
easily export their managed database list to the FileList where all other network users of DR receive their database information from, you
need an access code to simplify the process, please request the code from: alanwelsman@alanwelsman.co.uk
The bottom section of the help screen will show a link which when pressed, will download this user guide.
This is where you can adjust some of the parameters of DR, split into 3 main sections as follows:
DR v1.17
DR v1.18
Available

General
User
Info

Drawing Register
1
2a-2f
3a-3b
4a-4b
5a-5b
6a-6b
7

Please enter your site location name and email subject title your documents relate to >
Please enter 4 C/S-Path folder header codes & 2 Local new file found header codes >
Please enter the text to be displayed for New ¦ Open files within C/S-Path folders >
Automatically update the contents of C-Path ¦ S-Path folders during file open? >
File extension of document's e.g.: "pdf" ¦ File extension of FileList e.g.: "xls" >
Automatically update the Local database on file open ¦ Local or Network >
Enter code to enable export to remote "FileList" & delete physical files >

C-Path >
S-Path >
ChatPath >
WebPath >

A

> Your Site & Contract No Here <
D
E
G
K
New >
Open >
Yes
Yes
pdf
xls
No
Local

H

C:\Users\Alan Welsman\Desktop\
C:\Users\Alan Welsman\Desktop\Superseded\
C:\Users\Alan Welsman\Desktop\
http://www.ebay.co.uk/sch/

Top section - General User Info
Note: Right Mouse Click the question to have it's pre-set answer entered for you or simply Right Mouse Click "1" for all presets.
1. Site Name: Enter your site location name and email subject title - this name is used on all printed documentation and will be entered into
each speedmail as it's subject title.
2. Header Codes: Enter 4 path folder and 2 local new file header codes from the range "A" to "T".
What are header code's ?...... Understanding how header codes work.
When you open or create a new Microsoft Excel file, you will see the worksheets are always setup with column header codes in the form of
letters "A" to "IV" and row numbers starting at "1" to "65000" or so.
The column headers always start from left to right from "A" to "IV" - we are only interested in the first 20 columns "A" to "T".
From the list displayed in Pref's / Quick Search Display Properties, you will see a group of letters and numbers.
The letters in black represent the column header codes in the worksheet "Local", the numbers in red provide the format of the data within
each column and the word in blue is the column header name.
Example: "A" means column "A", "1" means to format the column as text "#", "Group" means the name at the header of column "A"
You can adjust all the column header names simply by changing the details within the "Pref's" worksheet, don't try to change the names
within the "Local" worksheet as the cells are locked.
DR has been setup in such a way you can choose which information from the "Local" database to include in relation to files found within the
path folders "Current" and "Superseded".
If you are unsure which codes to use, right mouse click each question to have the default answers automatically entered for you.
The default values will enable a fully functional search system and are as follows.
Note:
Items 2a to 2d relate to header codes showing information viewed within the "Current" and "Superseded" lists.
Items 2e to 2f relate to header codes showing information viewed within the "Local" list.
2a. A: Group - View the documents group's - examples could be electrical, mechanical and architects etc
2b. D: Number - View the documents unique reference number's ( this is also their file name's )
2c. E: Description - View the documents brief description's
2d. G: Date - View the documents creation date's
2e. H: Comments - When new files are found, the file name including a comment "Unknown" will be entered into the Local list.
2f. K: Date - When new files are found, the file name including today's date will be entered into the Local list.
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Pref's - continued
When you select the Quick Search, enter the word "Unknown" into the "Comments" search field to view all newly found files.
Open each file in turn recording specific details from each document and adding those details into the "Local" database.
When newer files are found, don't forget to move the local file to the superseded list by right clicking the old file.
3a. Path Folders: Within "Current" or "Superseded" database lists, amend "New >" files or "Open >" existing files text.
3b. Path Folders: Within "Current" or "Superseded" database lists, amend "New >" files or "Open >" existing files text.
4a. Automatic Updates: Enter "Yes" to automatically update the "Current" database when DR open's
4b. Automatic Updates: Enter "Yes" to automatically update the "Superseded" database when DR open's
5a. File Extension: Enter the file extension you wish DR to look for, normally "pdf" files but can be many others.
5b. Remove ".tmp": Each time Microsoft Excel opens an Excel file, it creates a duplicate data file of itself ending in ".tmp", this file is
sometimes left sitting on your hard drive when Excel finally closes. You can remove these temporary files automatically by typing "Yes" into
box 5b, all ".tmp" files will be deleted from the path folder regardless of what program has created them clearing up valuable hard drive
space.
6a. FileList Update: If DR is to be used as stand-alone and you want to create your own "Local" database, enter "No"
Note: Entering "Yes" to option 6a.
Each time you open DR, your personal "Local" database will be overwritten, DR will open the file "FileList.xls" from it's local or networked
location and copy it's database contents to your "Local" database, this will happen if your own database has a more up to date database.
The only reason for this, is to allow one document controller to manage one single database which is then distributed electronically to all
other networked users of DR, to stop this update or if you are managing your own database, simply enter "No".
6b. Local or Networked: If you are intending to manage your own "Local" database, enter "Local" or leave blank for default "Local".
If you are intending to receive your database from a networked location, enter "Net" or "Network" or "Networked".
DR will receive it's information to populate your "Local" database from your "Local" or "Network" folder.
7. Give DR permission to export to remote "FileList" & delete physical files - If you would like to use DR as an administrator and provide other
network users an administered database ( from any of your networked PC's ), you need to enter 2 codes into the spaces provided to perform
the automatic functions, simply enter the word "admin" into the left box then right mouse click the number "7".
Once both codes are entered press the "HELP" button, Excel will attempt to read the contents of the file "FileList" to compare it's database
against your own personal database to let you decide which way to transfer info, make the selection and the data will be copied. You will also
be permitted to delete networked files from the remote server drive, you will always be able to delete your own files using Windows Explorer.

Top section - C-Path >, S-Path >, ChatPath & WebPath
You must tell DR where your files are stored and how to display records, follow the example below to setup the folders.
1. Create a folder called "Drawings", inside that folder create another folder called "Superseded".
2. Place the file "Drawing Register.xls" inside the "Drawings" folder you just created then open DR, ensure to enable macro's.
3. If a message appears "Missing File FileList.xls", please allow DR to create one for you, select "Yes"
4. You must now tell DR / Pref's / Paths where to store or look for your files, several options are available.
4a. If you are using DR as a stand-alone version, press the "C-Path >" button to display the following C-Path dialogue box.

Pressing [ Yes ] will allow you to browse your file system.
Pressing [ No ] will show the Prefs storage Assistant where you can store or load settings from.

If you select [ Yes ], a "Browse for Folder" path box will appear, navigate to the folder "Drawings" then once found, select it and press "OK",
once you press "OK" the path will be entered for you.
If you select [ No ], a "Prefs Storage Assistant" dialogue box will appear, here you can store your database settings and load settings from up
to 20 previously stored records, any used buttons will be highlighted.
4b. If you right mouse click beneath the answer to "4a", the superseded file path will be automatically entered for you.
4c. If you are using DR on your own computer and are reading a folder across a network, again press the "C-Path >" button, then search across
the network to the "Drawings" folder, once found, select it and press "OK".
4d. Repeat the same procedure as item "4b" to enter the superseded path folder.
5. If you enter a folder path and at that location the folders do not exist, DR will attempt to create them for you.
6. ChatPath is the location of a shared network folder where chat messages will be placed by all DR users.
7. WebPath provides an alternative online search engine to display more details on products found within your database.

13

Pref's - continued
Example 1 - pdf database
You have created an asset database, and list products by their model number.
Using Quick Search to display items from your database, select the left column row number so it highlights yellow then press
the cell containing the model number, in the example above, Ebay will be displayed showing all its entries of your model number.
Example 2 - mp3 database
You have created a personal music database, and list tracks by their song name.
Using Quick Search to display tracks from your database, select the left column row number so it highlights yellow then press
the cell containing the song name, in the example above, Youtube will be displayed showing all its entries of your song name.
Note:

The use of the site names Ebay and Youtube are examples.
These sites provide an amazing choice of material which is only hyperlinked to whilst using DR.

Above: Prefs Storage Assistant.
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Middle section - Quick Search Display Properties
Header
Codes

A1
Group
K3
Received

Col Width's
132.57
132.57
132.57
132.57
132.57

Engine
A
B
C
D
E

B1
Building
L3
Sent
A+

10.57

Search1
A+ 10.57
A+ 10.57
A+ 10.57
A+ 10.57
A+ 10.57
( 1 ) Text
#

Format Codes

C1
Lev
M1
Sent To
B

D1
Number
N1
Method
9

Search2
B9
B9
B9
B9
B9

C

4

Search3
C4
C4
C4
C4
C4

E1
Description
O1
AI
D+

30

Search4
D+ 30
D+ 41
D+ 30
D+ 30
D+ 30

F5
Rev
P1
SI
E+

30

F

Search5
E+ 30
E+ 41
E+ 30
E+ 30
E+ 30

( 3 ) Dates
dd-mmm-yy

( 2 ) Numbers
#,##0.00_ ;[Red]-#,##0.00

G3
Date
Q1
Design

H1
Comments
R1
Drawn
4

G

Search6
F4
F4
F4
F4
F4

7

Search7
G7
I7
L9
O 15
R 15

I1
Scale
S1
Checked
K

J1
Size
T1
Approved

8

Search8
K8
J8
M 18
P 15
S 15

( 4 ) Money
£#,##0.00;[Red]-£#,##0.00

H+

30

Search9
H+ 30
K8
N 18
Q 15
T 15

( 5 ) Other
#0

This section of "Pref's", is to create up to 5 search engines, this is to help you search for groups of data to quickly find files.
Mentioned above was "Understanding Header Codes", this section is where you enter those codes ( default values entered ).
Detailed are 20 groups of text, each group consists of 3 parts, a letter "A", a number "1" and header text "Group".
Letters: You can not alter the letters "A" thru "T" , these are fixed, these represent the Excel column reference codes.
Numbers: You can set a format to each column via the numbers, 1: Text, 2: Numbers, 3: Dates, 4: Money, 5: Other ( your choice ).
Headers: You can amend the headers for each column, the details entered i.e "Group", "Building" etc, are only examples.
The following section details how the search engine will be laid out and how wide each column is to be set.
You can create 5 search engines referenced "A" thru "E", each search engine consists of 9 user input fields "Search1" to "Search9".
Assigned to each search column is a header code "A" thru "T" and a number representing a column width "10" etc.
By adjusting the number, you can adjust how wide you would like each of the search columns to be within the "Quick Search" page.
If you enter the number as "0", the column will be hidden from view so you can have a search engine consisting of lesser user inputs.
The next section are the numbers representing the format types, you can assign any of the formats to a column per search engine.
1: Enter the value "1" will view all results found in "Quick Search" as Text # ( you can adjust the items in red )
2: Enter the value "2" will view all results found in "Quick Search" as Numbers #,##0.00_ ;[Red]-#,##0.00 ( you can adjust the items in red )
3: Enter the value "3" will view all results found in "Quick Search" as Dates dd-mmm-yy ( you can adjust the items in red )
4: Enter the value "4" will view all results found in "Quick Search" as Money £#,##0.00;[Red]-£#,##0.00 ( you can adjust the items in red )
5: Enter the value "5" will view all results found in "Quick Search" as Other #0 ( you can adjust the items in red )
By adding a plus sign next to each letter i.e "A+" will allow the number of items found per search to be included within the column header.

Bottom section - Page Zoom - Auto or %
Page Zoom
Auto or %

Prefs
Yes

Current
Yes

Superseded
Yes

Local
96

Quick Search
Yes

DR is made up of 5 worksheets, "Pref's", "Current", "Superseded", "Local" and "Quick Search".
Because DR can be used across many computer systems using different monitor configurations, the screen resolution may not always be the
same on 2 different PC's, so Excel has an inbuilt feature where it can automatically adjust the active area to your screen regardless of it's
resolution.
The clever part to this feature is when the computer hosting DR is being remote controlled, the screen still automatically sizes to the available
screen size of the client in use i.e laptops, tablets, mobile phone etc.
Beneath each of the 5 worksheet names are 2 boxes, into the left box you can enter the word "Yes" for automatic page zoom or leave blank
then enter the numeric page zoom % into the right hand box, is a numeric value is not entered, a 100% default value will be used.
Enter this information for all 5 worksheets.
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Current
This is a database of files found within the C-Path folder "Drawings", this should be files currently in use and the latest revisions.
You can not enter any details into this list, it's function is to quickly list all files currently inside the "Drawings" folder.
When you select the blue-tab "Current", there may be nothing listed, this may be because you have chosen not to automatically update the
"Current" database on file open, to set to auto update, navigate to "Pref's" and change question "4a" to "Yes".
To manually update the database, press the "< Update" button located ( top right ), if you press it twice, you can see which files are new.
You can choose which details from the "Local" database to include within this list simply by adjusting the properties in " Pref's, 2a-2d".
DR will compare your current document filenames and highlight as red text if it finds any files which it believes may not need to be in this
folder, are they superseded document's?, if so right mouse click the known superseded files to be asked if you would like the document
moved into the superseded folder, select "Yes" for the move to be carried out for you. * this feature only happens in the Current folder *
Note 1: To sort the database, simply press the "Up" arrow key after pressing "< Update" on the column of choice.
Note 2: Pressing the very top address bar will take you to the current "C-Path" folder as written.
Note 3: New files are highlighted as "New >", and are only found when pressing the "< Update" button.
New files which are not currently listed within in the "Local" database are entered into the "Local" database for you.
When you then select the "Local" database, you will be taken to the list of the new files, simply add information against each new file.

Superseded
This is a database of files found within the S-Path folder "Superseded", this should be the out-dated files and not in use.
You can not enter any details into this list, it's function is to quickly list what files are inside the "Superseded" folder.
When you select the red-tab "Superseded", there may be nothing listed, this may be because you have chosen not to automatically update
the "Superseded" database on file open, to set to auto update, navigate to "Pref's" and change question "4b" to "Yes".
To manually update the database, press the "< Update" button located ( top right ), if you press it twice, you can see which files are new.
You can choose which details from the "Local" database to include within this list simply by adjusting the properties in "Pref's, 2a-2d".
If you see files listed and one of them is a current document, right mouse click it, you will be asked if you would like the document moved into
the current folder for you.
Note 1: To sort the database, simply press the "Up" arrow key after pressing "< Update" on the column of choice.
Note 2: Pressing the very top address bar will take you to the superseded "S-Path" folder as written.

Local
This is your managed database, the heart of DR and if networked, the database everybody else will use.
It's function is to allow you to electronically tag every document you have within the current folder "Drawings".
You only need to tag the new documents and leave the older document information intact, as this information is still searched upon.
So to recap, each time you or a colleague transfers new drawings or documents into the "Drawings" folder, then press twice the "<Update"
button whilst within the "Current" database, any new drawing or document found will have their file names automatically added into the
"Local" database, so when the "Local" database is selected, you will be guided to the new file list so you can start to add more information
about it.
During the filename entry, 2 other pieces of information will be entered, one is under comments called "Unknown" and the other under
received which will be the date when the file was added.
Use Quick Search to search for the word "Unknown" under the search header comments to see the newly added files.
Open each file in turn and add to the database the information about each drawing or document.
The header names within the "Local" database are adjusted in the "Pref's" page, the two entries above are changed via "Pref's, 2a-2d".
By pressing the header name will sort the list in an ascending or descending order.
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Quick Search & Hyperlinks
This is where you can quickly find and open drawings or documents matching any wildcard search from one or all of the 9 search inputs.
Starting on the left side, is a letter "A" and a number "1", note changing "A" to "F" will reprogram file hyperlinks between rows and columns.
A
1

Group

Building

Lev

Number

Description

Rev

Date

Comments

1

Mech

Jubilee

3rd

59M001

2

Doors

Jubilee

3rd

Z232A013-C1

Ward Block Roof Plant Bases

v1

04-Dec-12

First Issue

Third Floor & Roof Plan Door References

C1

08-Feb-13

See sheet info

3

Elec 2/8

Jubilee

3rd

WSP-0142-GA-620-03-101-AF

Small Power / Data / Telephone / CCTV

AF

27-Jan-14

As fitted

4

Elec 2/8

Jubilee

3rd

WSP-0142-GA-620-03-101-C1

Small Power / Data / Telephone / CCTV

C1

30-Nov-10

Issued for Construction Stage

5

Elec 2/8

Jubilee

3rd

WSP-0142-GA-620-03-101-T1

Small Power / Data / Telephone / CCTV

T1

17-Mar-10

Tender Issue

6

Architect

Jubilee

3rd

Z223A009-C2

Slab Penetrations Sht. 2 of 2

C2

24-Aug-12

No detail

7

Architect

Jubilee

3rd

Z223A008-C3

Slab Penetrations Sht. 1 of 2

C3

28-Aug-12

No detail

8
9

Elec 5/8

Jubilee

3rd

WSP-0142-GA-680-03-101-AF

Security / TV Sockets

AF

27-Jan-14

As fitted

Elec 5/8

Jubilee

3rd

WSP-0142-GA-680-03-101-C1

Security / TV Sockets

C1

30-Nov-10

Issued for Construction Stage

3

10

Elec 5/8

Jubilee

3rd

WSP-0142-GA-680-03-101-T1

Security / TV Sockets

T1

17-Mar-10

Tender Issue

11

Architect

Jubilee

3rd

Z002A013-C1

Room names and numbers - Sheet 2 of 2

C1

31-Jul-13

For information only

12

Architect

Jubilee

3rd

Z002A012-C1

Room names and numbers - Sheet 1 of 2

C1

31-Jul-13

For information only

13

Architect

Jubilee

3rd

Z002A014-C1

Room names and numbers - Roof Plan

C1

31-Jul-13

For information only

14

Mech

Jubilee

3rd

WSP-0142-GA-500-03-102-C1

Roof - Room Services Layout

C1

30-Nov-10

Issued for Construction Stage

15

Mech

Jubilee

3rd

WSP-0142-GA-500-03-102-C2

Roof - Room Services Layout

C2

05-Oct-12

Dry Riser details added

16

Mech

Jubilee

3rd

WSP-0142-GA-500-03-102-C3

Roof - Room Services Layout

C3

11-Jan-13

HUB Room DX Units relocated from Plantroom

17

Mech

Jubilee

3rd

WSP-0142-GA-500-03-102-T1

Roof - Room Services Layout

T1

17-Mar-10

Tender Issue

18

Schematic

Jubilee

3rd

WSP-0142-SC-500-XX-901-AF

Plantroom Schematic

AF

26-Mar-14

Drawing updated by Alan Welsman

19
20

Schematic

Jubilee

3rd

WSP-0142-SC-500-XX-901-C1

Plantroom Schematic

C1

30-Nov-10

Issued for Construction Stage

Schematic

Jubilee

3rd

WSP-0142-SC-500-XX-901-C2

Plantroom Schematic

C2

27-Nov-12

BDP Comments

21

Schematic

Jubilee

3rd

WSP-0142-SC-500-XX-901-P1

Plantroom Schematic

P1

04-Jan-10

Preliminary Issue

22

Mech

Jubilee

3rd

WSP-0142-GA-500-03-103-C1

Plantroom Plant Layout Piped & Ductwork

C1

30-Nov-10

Issued for Construction Stage
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Mech

Jubilee

3rd

WSP-0142-GA-500-03-103-C2

Plantroom Plant Layout Piped & Ductwork

C2

05-Oct-12

Ground floor Hub & Regen kitchen cooling relocated

24

Mech

Jubilee

3rd

WSP-0142-GA-500-03-103-C3

Plantroom Plant Layout Piped & Ductwork

C3

26-Nov-12

Sizes added to pipes as clouded

25

Mech

Jubilee

3rd

WSP-0142-GA-500-03-103-C4

Plantroom Plant Layout Piped & Ductwork

C4

29-Nov-12

Ductwork & Pipework amended, Bases added

26

Mech

Jubilee

3rd

WSP-0142-GA-500-03-103-C5

Plantroom Plant Layout Piped & Ductwork

C5

07-Jan-13

AHU 03 & 04 Valve sets relocated

27

Mech

Jubilee

3rd

WSP-0142-GA-500-03-103-C6

Plantroom Plant Layout Piped & Ductwork

C6

30-Jan-13

SF07 & EF08 Ref Added and Attenuator size

28

Mech

Jubilee

3rd

WSP-0142-GA-500-03-103-T1

Plantroom Plant Layout Piped & Ductwork

T1

17-Mar-10

Tender Issue

29

Mech

Jubilee

3rd

WSP-0142-GA-500-03-101-C1

Plantroom Plant Layout Main Plant

C1

30-Nov-10

Issued for Construction Stage

30

Mech

Jubilee

3rd

WSP-0142-GA-500-03-101-T1

Plantroom Plant Layout Main Plant

T1

17-Mar-10

Tender Issue

Blue: Current, Red: Superseded, Grey: Files not available, if Excel non responsive, start [Task Manager] then [Switch To] pdf application.

The letter "A" denotes which "Search Engine" is currently in use, you have 5 engines to choose between and are "A" thru "E".
To change to a different search engine, simply type or double click the letter "A", it will change to "B" then "C" and so on back to "A".
Each time the letter changes, the column headers and width's will also change as to what is pre-configured in "Pref's".
The number "1" denotes the starting number to list from during a successful search and can view up to 30 records at once.
If more than 30 records are found, simply enter a new list from number i.e. "31" ( top left ) to continue viewing additional records.
If you notice a record error or need to modify the results being viewed, simply right mouse click that result to be taken to that record.
Once the record has been modified, right mouse click anywhere on screen to jump back to the Quick Search page.
You will see there is a header bar, beneath each header title is an empty space to write a single word or a wildcard i.e. instead of writing the
full word distribution you simply write the letters dis and all entries with the letters dis inside them will be listed, entering ? into any search
box will list all its results, entering ?? into the Group search box will list the different types of groups.
Whilst searching, the left list from column may highlight red, this means there is a record duplication within the "Local" database.
Whilst searching, the search header's may highlight red, this means there are too many matches, make your search word longer to narrow.
You can arrange the search engines to display records in any way you wish, this is done in the "Pref's" page.
You can enter search strings in any random combination to help find your records.
You can select/unselect individual files from your results by selecting it's red row number, selections made will be highlighted in yellow.
To carry out special functions, simply right mouse click any of the search boxes, this will bring up the "Quick Search Options" box.
Select one of the options to carry out it's task for the individually highlighted results or if none selected, all results visible.
The bottom of the "Quick Search" is the Info bar which details what types (3) of files have been found as well as date information.
1. Blue results are current records within the "Drawings" folder and are the files currently in use and available for viewing.
2. Red results are superseded records within the "Superseded" folder and are the files not currently in use and still available for viewing.
3. Grey results are records of files listed only in the "Local" database, the file's don't physically exist within either path folder.
By pressing the info bar when the search fields are empty will display an options box allowing you to carry out functions during a search.
By pressing the info bar during a search, will present you an options box to adjust search dates, total columns or show the VAT Calculator.
Note: Quick Search hyperlinks to files to open them, sometimes Excel will try to open a file and may display a virus warning, this can
sometimes cause Excel to become non-responsive, if this happens Excel will appear to freeze or hang, please don't reset your PC as nothing is
wrong, simply start the "Task Manager" then "Switch To" the application of the document program you have tried to open, i.e pdf files will
require Adobe Acrobat, simply select Adobe Acrobat then press the "Switch To" button to resume the file open process.
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Quick Search - Keyboard Shortcut's & Mouse Shortcut's
Keyboard Shortcut's
There is only 1 keyboard shortcut, this is to perform the task of moving files whilst using "Quick Search" as this can be a quicker method.
Ensure the filename is the item selected onscreen, use the keyboard arrow keys to navigate to the chosen file prior to pressing CTRL+m.
1. CTRL+m: Move a specific file ( one hignlighted from the quick search results ) between the current and superseded folders.

Mouse Shortcut's
4. Right Mouse Click: To see a list of options you can perform using "Quick Search", right click within the white space shown below if the form
is displaying search results or right mouse click anywhere onscreen where results are not shown.
A
1

Group

Building

Lev

Number

Description

Rev

Date

Comments

You will be presented with a "Quick Search Options" dialogue box with 13 options you can choose from.

1. Open
2. Clone
3. Print
4. Delete
5. Speedmail
6. Mailing List
7. Dropbox
8. Change DB
9. Refresh
10. Messages
a. Donations
b. Backup
c. Menu 2

Open to view the files matching the results shown on the Quick Search page.
Clone all or 1 single file as detailed on line 1 from a remote location to your PC.
Print without viewing the files matching the results shown on the Quick Search page.
Delete files matching the results shown within the Quick Search page.
Email the files matching the results as shown on the Quick Search page.
Add up to 180 recipient email addresses in groups of 10 to help speedmail documents.
Press this button to open the folder containing your current documents to add files into.
Open / load the contents of another database located locally or on your network server.
Refresh both document folders, select if you have recently pressed Save or Save As.
Message another user of DR if they are on the same LAN & sharing the same network folder.
Please help towards the costs of keeping Drawing Register alive by an any amount donation.
Backup the details of both Prefs and Local worksheets to the FileList file.
Goto Menu 2.

11. 1Ph Calc
12. User Guide
13. 3Ph Calc
14. Show n/a
15. VAT Calc
16. Del Tmp's
17. Inc Totals
18. Hyperlinks
19. Clean DB's
20. About
a. Donations
b. Erase Data
c. Menu 2

Electrical Engineering tools: 1 Phase Calculator - Calculate single phase loads.
View this user guide.
Electrical Engineering tools: 3 Phase Calculator - Calculate three phase loads.
Display or Hide results where files are not available.
Show the VAT calculator.
Delete temporary *.tmp files from within the C-Path folder.
Total each column, results are shown as numbers or currency.
Change hyperlinks to open local or web-based results.
Clear formats from the worksheets Current, Superseded and Local databases.
View information for Client, domain name & Excel version.
Please help towards the costs of keeping Drawing Register alive by an any amount donation.
Erase all your data contained within Drawing Register to it's original state.
Goto Menu 1.

1. Top
2. From

This is an information panel.
Enter a date in the format dd/mm/yyyy then press the button "Apply Dates"
Leaving blank will use the date 01/01/1900
Enter a date in the format dd/mm/yyyy then press the button "Apply Dates"
Leaving blank will use the most highest date within your database.
Press this button to apply dates, it will turn red when needing to be pressed.
Press this button to display the added totals of columns within the info bar.
Press this button to display the VAT Calculator.
Press for Last Financial Year / Last Year / Last Month / Last Week
Press for This Financial Year / This Year / This Month / This Week

3. To
4. Apply Dates
5. Total Columns
6. VAT Calculator
7. Preset Buttons
8. Preset Buttons

The pre-set dates are as follows:

Financial Year: 06/04/yyyy to 05/04/yyyy / Year: 01/01/yyyy to 31/12/yyyy
Month: 01/mm/yyyy to 31/mm/yyyy / Week: dd/mm/yyyy to dd/mm/yyyy ( Mon to Sun )
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Speedmail
Speedmail has been written into DR to help you reduce the time taken in attaching specific documents to your emails.
1. Using Quick Search, search and display for your documents, select the documents you need to email then right click an empty cell.
2. From the Options menu, select Speedmail.
3. If you have already pre-entered email addresses into your mailing list you will be presented with a list to select your recipients from.
4. Select your recipients by selecting To or Cc then close simply the dialogue box to start the email process.
5. Thats it..... Easy.
Note: To help your recipients build their database, included with your email will be a special file called Speedmail.xls or Speedmail.xlsb.
This file will include from your local database, the information from each attached document within your new email.
When your colleague receives your email, they may save all the attached document's including Speedmail to their drawings folder.
Your colleagues can update their own DR databases simply by selecting the worksheet "Local" and allowing DR to auto import & update.
DR will continually check for new Speedmail updates and if it finds one, will ask your permission if it's OK to import it's data.
Ensure your colleague has his/her DR database setup the same as your own as information will be copied as laid out in yours.
By choosing [ Yes ], the Speedmail file will be opened, it's data imported, closed, then Speedmail will be permanently deleted automatically.
By choosing [ No ] will leave Speedmail alone until you either manually move or delete it from the Drawings folder.

Which files can I email
If only current ( blue ) results are shown during your search, these files will be attached automatically to your email without menu.
If both current and superseded ( red ) files are shown during your search, you will be presented with the following 3 questioned menu.
Q1. Would you like to email all visible onscreen document's?
Y: Proceed to Q2.
N: Exit the speedmail menu.
Q2. Attach superseded document's too?
Y: Both current and superseded files are attached to an email for you.
N: Proceed to Q3.
Q3. Attach only superseded document's?
Y: Only superseded files are attached to an email for you.
N: Only current files are attached to an email for you.

Speedmail Worksheet
List 1:

Site Team 1
example1@siteteam1
example2@siteteam1
example3@siteteam1
example4@siteteam1
example5@siteteam1

List 2:

Site Team 2

List 3:

Designers

example1@siteteam2
example2@siteteam2
example3@siteteam2
example4@siteteam2
example5@siteteam2
example6@siteteam2
example7@siteteam2
example8@siteteam2

↑ above is a screenshot of 3 from 18 groups of
recipients stored within the worksheet Speedmail.
Arranged in 18 groups of 10, give each group a
unique name then add up to 10 email addresses
per group.

← When you press the Speedmail button from
the Quick Search options, you will be shown your
speedmail groups list, select your recipient groups
then close the menu to start you email process.
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Quick Search - Chat
If you would like to send a message to another DR user ( attached on same LAN as your own PC and sharing the same server folder ), right
mouse click any empty cell in the Quick Search header bar to bring up the DR.Chat box.
A
1

Group

Building

Lev

Number

Description

Rev

Date

Comments

You will be presented with a "DR.Chat" dialogue box.

< Your ID: Your windows login user name will be entered for you.
( when you are online, other chat users will see you )

< Recipient's message: A senders message will be shown here
showing its date and time sent.
< All current users of DR will be listed in the Currently Online box.
( Press Currently Online to show who is Currently Offline & vice versa )

< Send to: Enter a recipients user's login name.
( select by highlighting a recipient from the Currently Online list )

< Your message: Enter a new message or reply to messages sent to you.
< Press the SEND button to send a new or reply to messages sent to you.
Changing your ID
You can change "Your ID >" if you are setup as an administrator and by typing the word "admin" into the "Send to" input box.
Press the small button located in the bottom right hand corner of the lower message box labelled "Your message".
The following "DRChat Setup" dialogue panel will be displayed.

This shows current "Your ID >" which can only be change by typing a "New ID >".
To do this, enter a "New ID >" into the top right input box then press the white text "New ID >" to save the settings then press "EXIT"
This will return you to the "DRChat" box where "Your ID >" has now changed and your user name appears in the currently online list.
Other users sharing the same "ChatPath" directory as your own version of "DR" will be listed in the "Currently Online" list.
Select one of the their listed names to have their name entered into the "Recipients username" box for you.
Enter your message into the bottom box then press "SEND" when done.
To see a list of offline users, press the text "Currently Online" to change the list to "Currently Offline" and vice-versa.
If you send a message to an offline user it will sit until they next use "DR", when they will receive and view your waiting message.
One the message had been displayed, the message will then be deleted from the server.
Note: All messages utilise the notepad file system, your messages are contained within the notepad text files.
The recipients name of the message is encrypted, the body of the message is further encrypted.
Your ID>: The default name is your Windows login user's name, it can be changed as detailed above.
Send to>: This is the name of another "DR" user's name, choose a name from the right hand listbox.
Currently Online: This is a list of users currently online and sharing your server folder.
Currently Offline: This is a list of users currently offline and sharing your server folder.
The "ChatPath" is the server folder location where your messages will be stored, all users should use the same path folder.
When you initiate a message, you start a 15 second loop where your PC will continually check for new messages and display them if they are
available.
When you close "DR", the 15 second timer is stopped.
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Macro's - Automated Routines
All the macro's within Drawing Register can be accessed from "Quick Search", right click an empty cell to bring up the options dialogue box.

Flow Chart
The following flow chart shows how DR works and it's sequence of carrying out it's tasks.

21

Drawing Register.xls
File Open

No

Create "FileList.xls" Y/N

Yes
Enable Macro's Y/N

Automatic Functions Disabled

No

Automatic Functions Enabled

Yes

If "Prefs Q6a" is "No"

Does "FileList.xls" Exist?
( Local Backup Database )

Press "HELP" for more information

FileList data will not copied

Help

Provides a quick setup guide

Press the "Path >" button

Folder ?

Navigate to any desired folder

Sort each column by arrowing

Sort & Print

up at the top of each column

Press the "SS Path >" button

Folder ?

Navigate to any desired folder

Sort each column by arrowing

Sort & Print

If "Prefs Q6b" is "Net" or "Network"

( Right Click Q1 for defaults )

Copy FileList from Network location

Setup "Current" Path

If "Prefs Q6b" is "Local" or blank

( Right Click space for defaults )

Copy FileList from local machine

Select "Current"

File Check

Auto Fill

Press the "< Update" twice

Press the "< Update" button

New files added to "Local" list

Setup "Superseded" Path

Right Click "File Name" to move files

( Right Click space for defaults )

between "Current" & "Superseded"

Select "Superseded"

File Check

Press the "< Update" button

up at the top of each column

If "Local" is empty, a new

Setup "Prefs" Q1-Q7

Select "Local"

database will be copied into it

New files added, please tag

If "Prefs Q6b" is "Local"

Select "Quick Search"

Local database will be copied

Sort by pressing column headers

Press the "< Update" twice
New files added to "Local" list

< New Files

Right
Click

"Quick Search Options"
Choose one of the 5 options

Use upto 9 *wildcard* search strings

Press "Ctrl+Shift+C" or click

If "Prefs Q6b" is "Net" or "Network"

Press "A" to rotate engine thru to "E"

Clone remote files to local machine

Network database will be copied

Amend "1" to list more results

Press "Ctrl+Shift+D" or click

Click any row No. to open drawings

Delete all path file's & "Local" records

View current & superseded files

Press "Ctrl+Shift+O" / "P" or click

Hide missing files from search view

Open or Print all visible path file's

If "Prefs Q6b" is "Net" or "Network"
Administrator Privileges

Admin

Press to "Speedmail" viewed records
If "Prefs Q7" is entered

Press "Save As"

Email options all visible path file's

Administrator Privileges

Drawing Register - Backup.xls

Press to "Refresh" viewed records
Will update path file lists

Press "Close"

Press to "Master Reset"

Drawing Register - Auto Save

Return to original settings

This user guide has been written by Alan Welsman and is subject to change without notice, v1.24 dated 21st March 2017.
Drawing Register is protected under the UK copyright law, Copyright © 2015-2017. All rights reserved.
This work is registered with the UK Copyright Service: Registration No: 284692166.
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